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UNIVERSIDAD DE LOS ANDES-TRUJILLO 
SALA DE GEOGRAFÍA Y CARTOGRAFÍA 

PROF. JOSÉ ROA 
Semestre B-2015 

 
ELABORACIÓN DEL PORTAFOLIO GEOGRÁFICO Y CARTOGRÁFICO 

 DEL ESTADO TRUJILLO 
 
INTRODUCCIÓN 
 
El portafolio geográfico propuesto en esta práctica persigue la colección sistemática de capas 
cartográficas representativas de variables geográficas del estado Trujillo – Venezuela. Luego esta 
recopilación de capas es ensamblada para elaborar los diferentes mapas geográficos representativos 
tanto de aspectos básicos como temáticos de la geografía trujillana. El portafolio difiere del atlas 
porque mientras este último es un producto substancioso dirigido al total de la comunidad lectora, que 
complementa la información cartográfica con documentación estadística, histórica y geográfica, y 
ofrece un acabado orientado según el objetivo del autor o del editor, el portafolio es personal, y un 
primer paso en el proceso de la elaboración del atlas, al ser una  recopilación en proceso de 
información tanto documental como de situaciones del acontecer en tiempo real, tales como 
calamidades físico naturales, de los espacios en conflicto y de nuevas investigaciones sobre el 
ambiente. Gracias a los SIG e información georreferenciada, el portafolio puede ser dinámico, 
interactivo y de constante renovación, convirtiéndose en el apoyo cartográfico de todo profesional de la 
geografía en la cotidianidad de su ejercicio. Esta práctica contempla  la elaboración de un portafolio 
geográfico y cartográfico para el municipio Campo Elías del Estado Trujillo – Venezuela, lo cual 
servirá de ejemplo para la elaboración independiente por parte de los estudiantes de un portafolio 
similar pero de los restantes municipios del estado. El soporte lógico a utilizar son: El SIG ILWIS, un 
visor y editor de imágenes como IrfanView y algún diagramador multimedia como Power Point u 
OpenOffice Impress. 
 
 
 
OBJETIVOS  
 
Objetivo principal: 
    

El objetivo principal es la elaboración de un portafolio geográfico 
digital de un determinado municipio del estado Trujillo – 
Venezuela. 

 
Objetivos específicos: 
 

1.-  Selección y digitalización de los límites de un municipio 
determinado y sus parroquias que conforma el estado Trujillo 
y poligonización de sus áreas. 

2.-  Definición y digitalización de las áreas urbanas, vías y 
drenajes que presenta el municipio seleccionado. 

3.-  Composición de capas para generar vistas cartográficas 
sobre aspectos geográficos del municipio seleccionado.   

4.-  Elaboración de mapas finales a partir de las vistas. 
5.-  Presentación final del portafolio en formato pdf. 
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DATOS Y MÉTODOS 
 
 
Los datos a utilizar en esta práctica están representados por un conjunto de capas cartográficas 
georreferenciadas, cinco (5) en formato vectorial y diez y siete (17) en formato raster, las cuales 
ilustran características geográficas básicas y temáticas del estado Trujillo – Venezuela (Cuadro 1).   
 
 
Cuadro 1.- Denominación, formato y descripción de las capas cartográficas a utilizar en este ejercicio.    
FORMATO NOMBRE GEORREFERENCIA / 

SISTEMA COORD. DESCRIPCIÓN 
- AGUA Embalses de Masparro y Boconó Tucupido. Lago de Maracaibo 
- CLIMA_KOPPEN Clasificación climática según el sistema de Köppen. 
- EMBALSE_AGUA_VIVA Embalse de Agua Viva. 
- HIDROGRAFIA_TRUJILLO Sistema de drenaje del estado Trujillo 

VECTORIAL 

- TRUJILIMITE 

trujillo5 

Límites del estado Trujillo 

- ABRAE_TRUJILLO Imagen tif 
Áreas bajo régimen de administración especial en el estado 
Trujillo 

- COBERTURAS_1996 453 / 453 
Clasificación de coberturas a partir de un NDVI LANDSAT de 
1996 

- GEOLOGIA Estructuras y litología  

- GEOMORFOLOGÍA 

trujimapa10 / 
TRUJILLO250 
 Zonificación geomorfológica 

- MED_ESTADO 
p006r0537b / 
p006r0537b Modelo de elevación digital (90m) recortado al estado Trujillo 

- MED_REGIONAL 
Modelo de elevación digital (90m) del estado Trujillo y 
vecindades 

- PISOS_ALTITUDINALES Clasificación de rangos altitudinales 
- TEMPERATURA Distribución de la temperatura (°C) 
- pp_1998_2014 Distribución de la precipitación media anual 1998 – 2014 (mm) 
- PISOS_TERMICOS 

MED8 / trujillo5 

Clasificación de pisos térmicos altitudinales 
- TRUJILLO_MUNICIPIOS Imagen tif División municipal y parroquial del estado Trujillo (SHT, 1996) 
- B1_LANDSAT19960813 Imagen LANDSAT 5 TM  banda 1 (canal azul) 
- B2_LANDSAT19960813 Imagen LANDSAT 5 TM  banda 2 (canal verde) 
- B3_LANDSAT19960813 Imagen LANDSAT 5 TM  banda 3 (canal rojo) 
- B4_LANDSAT19960813 Imagen LANDSAT 5 TM banda 4 (canal infrarrojo cercano) 
- B5_LANDSAT19960813 Imagen LANDSAT 5 TM banda 5 (canal infrarrojo medio) 

RASTER 

- B7_LANDSAT19960813 

453 / 453 

Imagen LANDSAT 5 TM banda 7 (canal infrarrojo medio) 
 
 
El método de trabajo consiste en la preparación de la data, el diseño del mapa y la colección final de 
estos en un portafolio. Para esto se requiere de la selección, definición y extracción de información 
geográfica que luego puede ser combinada en una vista integral y generar posteriormente un mapa 
básico o temático del área seleccionada. La cantidad y calidad de mapas incluidos en un portafolio 
depende del manejo de la información geográfica, la creatividad y los fines propuestos.  
 
El método de trabajo requiere desarrollar una serie de actividades señaladas en el cuadro 2.  
 
El soporte lógico a utilizar son: El SIG ILWIS, un visor y editor de imágenes como IrfanView y algún 
diagramador multimedia como Power Point u OpenOffice Impress. Estos soportes están disponibles en 
las unidades de computación de la Sala de Geografía, sin embargo podría usar  algún otro paquete de 
uso libre. Para fines de este ejercicio las definiciones de mapas y capas son equivalentes.  
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Cuadro 2.- Secciones, actividades y herramientas a desarrollar para la elaboración del portafolio. 
SECCIÓN DE LA 

PRACTICA 
ACTIVIDADES HERRAMIENTAS 

1.-  Importar una imagen raster 
2.-  Recortar una imagen raster 
3.-  Extraer información geográfica de una imagen raster a 

través de la digitalización. Crear capas de segmentos 
4.-  Definir información geográfica de una imagen raster a 

través de la digitalización. Crear capas de polígonos 

 PORTAFOLIO SECCIÓN 1.  

PREPARACIÓN DE LA 
DATA  

5.-  Vectorizar una capa raster a una capa de polígonos. 

- SIG ILWIS 

6.-  Crear una composición (vista) de capas 
7.-  Crear plantilla (layout)  PORTAFOLIO SECCIÓN  2. 

DISEÑO DEL MAPA 
8.-  Diseño de los mapas 

- SIG ILWIS 
- POWER POINT / 
OPENOFFICE 
IMPRESS. 
- IRFAN VIEW 

 PORTAFOLIO SECCIÓN  3. 

COLECCIÓN DEL 
PORTAFOLIO 

9.-  
Presentación final en formato pdf. 

- POWER POINT / 
OPENOFFICE 
IMPRESS. 
- IRFAN VIEW 

 
ÁREA DE ESTUDIO 
El área de estudio a desarrollar en esta práctica es alguno de los 20 municipios de estado Trujillo - 
Venezuela (Figura 1). Para efectos demostrativos en este ejercicio se desarrollará el portafolio del 
municipio Juan Vicente Campo Elías. 
 

 
Figura 1. División municipal y localización relativa del estado Trujillo – Venezuela (2015) 
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- PORTAFOLIO SECCIÓN 1.  

PREPARACIÓN DE LA DATA 
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PROCEDIMIENTO 
 
1.- Inicie el SIG ILWIS y utilice el explorador de este para localizar la carpeta donde se encuentra los 
datos correspondientes al ejercicio PORTAFOLIO (Figura 2).   
 

 
Figura 2. Ubicación de la carpeta de datos con el navegador del ILWIS 

 y archivos que contiene PORTAFOLIO. 
 
 
1.1.- Además de las 5 capas vectoriales y 8 capas raster, en este archivo están presentes los dominios, 
representaciones, sistemas de coordenadas y georeferencias asociadas a tales capas. Solo faltan dos 
capas raster que serán importadas mas adelante. 

 
 

RESPONDA EN 
LA PLANTILLA 
DE EVALUACIÓN  
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2.- IMPORTAR UNA IMAGEN RASTER.  
 
2.1.- Para representar las características geográficas del municipio Juan Vicente Campo Elías es 
necesario generar el mapa base, el cual además de mostrar los límites del municipio, se delinearán los 
límites parroquiales. Se requiere un mapa básico del estado Trujillo con sus divisiones administrativas, 
utilizaremos para ello el mapa producido por la empresa Sistema Hidráulico Trujillano en 1996 y 
reeditado en el 2001.  
 
Este mapa está en formato GeoTiff, lo cual es un estándar que permite que la georeferencia de un mapa 
o capa cartográfica raster se enlace al archivo de imagen de formato TIFF, en otras palabras, una 
imagen / mapa / capa,  de alta resolución (Tiff), contiene información espacial relativa a su proyección, 
elipsoide, datum y sistemas de coordenadas (Geo). 
 
La importación de un mapa en formato GeoTiff a un SIG facilita su lectura, ahorra el proceso de 
georreferenciación manual y asegura una mayor precisión de la data.  
 
El archivo a importar se llama TRUJILLO_MUNICIPIOS y se encuentra en la data provista para el 
ejercicio sin embargo, no puede ser visualizada a través del explorador del ILWIS ya que aún no ha 
sido importada.     
 
2.2.- Para hacer la importación vaya a File > Import > General Raster  (Figura 2.2) 
 
 

 
Figura 2.2  

 
 



 7 

2.3.- En la ventana de dialogo (Figura 2.3),  escoja Tagged Image File Format.TIF como formato de 
importación (Import Format), luego seleccione el archivo TRUJILLO_MUNICIPIOS.tif, y asigne 
como nombre de archivo de salida (Output Filename) el mismo nombre, click OK. 
 

 
Figura 2.3  

 
2.4.- Este protocolo permite entonces la importación de una imagen GeoTiff,  transformando esta en 
formato ILWIS y de esa manera su lectura y procesamiento dentro del SIG. Una vez importada dentro 
del ILWIS la imagen muestra además del archivo del mapa, los correspondientes a su sistema de 
coordenadas y georeferencia. (Figura 2.4). Despliegue el mapa TRUJILLO_MUNICIPIOS y diferencie 
en el los límites municipales, los parroquiales, ciudades, carreteras y ríos. 
 

 
Figura 2.4  
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3.- RECORTAR UNA IMAGEN RASTER.  
 
3.1.- Dado que en este ejercicio trabajaremos con el municipio Juan Vicente Campo Elías, necesitamos 
recortar el mapa TRUJILLO_MUNICIPIOS a un cuadrante que incluya solo el municipio. 
 
Para ello desplegamos el mapa y nos acercamos al municipio imaginando el cuadrante donde lo 
queremos enmarcar, necesitamos determinar con la ayuda del cursor dos coordenadas una coordenada 
inicial y otra opuesta. 
 
Estas coordenadas son de formato UTM, escriba aparte estas coordenadas que usaremos en el siguiente 
paso (Figura 3.1).  
 

 
Figura 3.1  

 
En este ejemplo las coordenadas son: Inicial            371133.71  /  1032434.73 
     Opuesta          388307.84  /  1054301.08 
 
 
3.2.- Ahora vamos a la pantalla maestra del ILWIS y escogemos en la lista de operaciones  (Operation-
List ),  y click en el comando SubMap of Raster Map, se despliega la pantalla de diálogo y seleccionará 
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el mapa TRUJILLO_MUNICIPIOS , el recorte se hará en base a las coordenadas determinadas en el 
item 3.1 y como nombre al nuevo mapa le asignaremos MUN_CAMPO_ELIAS, click en Show (Figura 
3.2.)  

 
Figura 3.2  

 
 
3.3.- Una vez desplegado el nuevo mapa MUN_CAMPO_ELIAS, escriba aparte el nombre de las 
parroquias que constituyen el municipio (Figura 3.3) 
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Figura 3.3  

 
VAYA A LA PLANILLA DE 
EVALUACIÓN Y ESCRIBA LAS 
COORDENADAS INICIALES Y 
OPUESTAS UTILIZADAS, ASI 
MISMO INSERTE  UNA 
CAPTURA DE PANTALLA DEL 
MAPA CREADO A PARTIR DEL 
RECORTE. 

 

 
 
4.- EXTRAER INFORMACIÓN GEOGRÁFICA DE UNA IMAGEN RASTER A TRAVÉS DE LA 
DIGITALIZACIÓN. CREAR CAPAS DE SEGMENTOS 
 
4.1.- LÍMITES MUNICIPALES. En la misma ventana donde está desplegada la imagen de 
MUN_CAMPO_ELIAS, genere un mapa de segmentos (segment map), a través de los comandos 
ilustrados en la Figura 4.1. 
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Figura 4.1. 

 
4.2.- En la ventana de dialogo (Figura 4.2),  asigne el nombre MUNICIPIO_CAMPO_ELIAS, como 
nombre del mapa de segmentos a crear. Dado que el mapa se esta creando sobre la imagen 

MUN_CAMPO_ELIAS, éste utilizará el sistema de coordenadas  TRUJILLO_MUNICIPIOS. 
 
El sistema ofrece crear el mapa bajo un dominio Unique ID, sin embargo se recomienda crear un 
dominio clase que integre las características geográficas que queremos definir en este ejercicio. Haga 

click en la casilla inmediata a la voluta de desplazamiento  , y abra la ventana de dialogo para crear 

el nuevo dominio . Escriba LIMITE como Domain Name y active la casilla class, lo cual es 
indicativo que el dominio a crear es de clases. Click OK en la ventana de Create Domain. 
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Figura 4.2. 

 
 
4.3.- Se despliega la ventana de dialogo para la creación del dominio clase LIMITE. En este dominio se 
crearán las diferentes clases con las cuales se describirán los tipos de límites a encontrar en el 

municipio. Para añadir estas clases haga clic  en el ícono . Las clases a añadir son: 

LIMITE_MUNICIPAL, y LIMITE_PARROQUIAL. Posteriormente y a través del ícono ; 
seleccione los colores representativos de éstas (Figura 4.3)     
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Figura 4.3 

 
 
 
 
4.4.- Cierre las ventanas correspondientes a Representación y Dominio y finalmente haga clic en OK 
en la ventana de creación del mapa de segmentos. De esta manera usted ha entrado en el editor del 
mapa de segmentos  y se dispone a trazar las características geográficas ya mencionadas. 
 
 
 

4.5.- Trace el curso correspondiente al límite municipal de Campo Elías , una vez terminado revise 
la consistencia de los segmentos mediante el modulo de chequeo que se muestra en la Figura 4.5a, los 

íconos . y  , son útiles para la corrección de los problemas de solapamiento, intersección y 
terminaciones que puedan presentar los segmentos, asegúrese que los segmentos sean consistentes en 
cuanto a su definición tal como se muestra en la Figura 4.5b. Los Segmentos que definen el límite 
municipal deben conformar un polígono cerrado. Una vez terminada la digitalización salga del editor 

de mapas de segmentos , de esta manera todo el trazado elaborado se guarda automáticamente 
(Figura 4.5c). 
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Figura 4.5a 

 

 
Figura 4.5b 
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Figura 4.5c 

 
 
 

HAGA UNA CAPTURA DE 
PANTALLA DE ESTE 
TRAZADO DE SEGMENTOS Y 
PONGALA EN LA PLANTILLA 
DE EVALUACIÓN 

 

. 
 
4.6.- Cierre todas las ventanas y regrese a la pantalla maestra del ILWIS. 
 
 
5.- VÍAS. Otra capa importante a extraer es la correspondiente a vías, despliegue el mapa 
MUN_CAMPO_ELIAS, genere un mapa de segmentos (segment map), a través de los comandos 
ilustrados en la Figura 5.1. 
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Figura 5.1. 

 
 
 
5.2.- En la ventana de dialogo (Figura 5.2.),  asigne el nombre VIAS_CAMPO_ELIAS, como nombre 
del mapa de segmentos a crear. Dado que el mapa se esta creando sobre la imagen 

MUN_CAMPO_ELIAS, éste utilizará el sistema de coordenadas  TRUJILLO_MUNICIPIOS. 
 
El sistema ofrece crear el mapa bajo un dominio Unique ID, sin embargo se recomienda crear un 
dominio clase que integre las características geográficas que queremos definir en este ejercicio. Haga 

click en la casilla inmediata a la voluta de desplazamiento  , y abra la ventana de dialogo para crear 

el nuevo dominio . Escriba VIAS como Domain Name y active la casilla class, lo cual es indicativo 
que el dominio a crear es de clases. Click OK en la ventana de Create Domain. 
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Figura 5.2. 

 
 
5.3.- Se despliega la ventana de dialogo para la creación del dominio clase VIAS. En este dominio se 
crearán las diferentes clases con las cuales se describirán los tipos de límites a encontrar en el 

municipio. Para añadir estas clases haga clic  en el ícono . Las clases a añadir son: 

VIA_PRINCIPAL, y VIA_SECUNDARIA. Posteriormente y a través del ícono ; seleccione los 
colores representativos de éstas (Figura 5.3)     
 

 
Figura 5.3. 
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5.4.- Cierre las ventanas correspondientes a Representación y Dominio y finalmente haga clic en OK 
en la ventana de creación del mapa de segmentos. De esta manera usted ha entrado en el editor del 
mapa de segmentos  y se dispone a trazar las características geográficas ya mencionadas. 
 
 
 
5.5.- Trace el curso correspondiente a la vía principal que se delinea en el mapa municipal de Campo 

Elías , una vez terminado revise la consistencia del nombre de los segmentos estos deben ser  
consistentes en cuanto a su definición tal como se muestra en la Figura 5.5. Esta capa de segmento no 
conforma un polígono cerrado, por lo que no amerita el mismo chequeo que se realizó en la 
digitalización del municipio o las parroquias. Una vez terminada la digitalización salga del editor de 

mapas de segmentos , de esta manera todo el trazado elaborado se guarda automáticamente. 
 
 

 
Figura 5.5. 
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5.6.- CIUDADES. Las ciudades y pueblos son 
expresión del espacio geográfico urbano, por 
lo tanto debemos representar la poligonal 
urbana de Campo Elías. Al igual que los 
anteriores casos debemos crear una capa de 
segmentos que represente el asentamiento 
urbano de Campo Elías.  
 
Dado que el proceso es similar a lo anteriores, 
en las siguientes figuras (5.6a, 5.6b, 5.6c), 
tendrá una guía para su elaboración. Tome 
nota que los límites de la ciudad conforman un 
polígono por lo que luego de la digitalización 
deben ser verificados. 
 

 
Figura 5.6a 

 
 

 
Figura 5.6b 

 
Figura 5.6c 

 
 
 
 
 
 
Cierre todas las ventanas y regrese a la pantalla maestra del ILWIS. 
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6.- RECORTANDO OTRO PRODUCTO RASTER.  
 
En el ítem 3, se explicaba el procedimiento para recortar una imagen raster, en este aparte 
procederemos a realizar el corte del MED_REGIONAL a un cuadrante que incluya solo el municipio. 
 
Aunque pueden desplegarse como tal, los MED no son imágenes pues no reproducen el hecho 
geográfico y su distribución en la superficie espacial, los MED basados en el radar como el MED 
SRTM (Shuttle Radar Topographical Missión 2000), son producto de una estimación de la altura de la 
superficie a través de pulsos de radar y que luego son ensamblados mediante técnicas de interpolación 
y ordenados en una matriz de datos cartesiana tal como sucede con las imágenes satelitales. 
 
 
 
El procedimiento para recortar el mismo que se describió en el ítem 3     
 
6.1.- Vaya a la pantalla maestra del ILWIS y escoja en la lista de operaciones  (Operation-List ),  y 
click en el comando SubMap of Raster Map, se despliega la pantalla de diálogo, seleccione 
MED_REGIONAL, el recorte se hará en base a las coordenadas determinadas en el item 3.1 y como 
nombre al nuevo mapa le asignaremos MED_CAMPO_ELIAS, click en Show (Figura 6.1)  
 
Coordenadas:     Inicial            371133.71  /  1032434.73 
     Opuesta          388307.84  /  1054301.08 
 

 
Figura 6.1  

Los MED expresan la altitud en msnm 
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6.2.- Una vez desplegado el nuevo mapa MED_CAMPO_ELIAS, superponga la capa 
HIDROGRAFIA_TRUJILLO, y la ciudad de CAMPO_ELIAS. 
 
 
Al hacer click en el ícono de   MED_CAMPO_ELIAS se despliega la ventana de opciones de 
despliegue donde se aporta información sobre máximo y mínimo de las unidades representadas y el 
tipo de representación, el cual en este caso es pseudocolor, la cual es una paleta cambios graduales  que 
va desde el azul  hasta el magenta. Revise el producto logrado, defina  (Figura 6.2). 
 
 
 
 

 
Figura 6.2 
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6.3.- Responda las siguientes preguntas en la planilla de evaluación 
 

 
 
 
 
- De acuerdo a la gradación de colores que presenta 
el MED_CAMPO_ELIAS, estime la altitud en msnm 
que representa cada tono señalado  

 
 

 
 
 
 
- Cual es la dirección de flujo del Río Negro / Río 
Boconó. 
 
 
- Cual es la dirección de flujo del Río Saguaz 
 
 
- Hacia cual dirección se encuentran las mayores 
alturas. 
 
 
- Hacia cual dirección se encuentran las menores 
alturas. 
 
  

 
 

 
VAYA A LA PLANILLA DE 
EVALUACIÓN, CONTESTE 
LAS PREGUNTAS E INSERTE  
UNA CAPTURA DE PANTALLA 
DEL MED CREADO A PARTIR 
DEL RECORTE. 

 

 
 
Al finalizar, cierre todas las ventanas y regrese a la pantalla maestra del ILWIS. 
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7.- HIDROGRAFÍA. La hidrografía del municipio también puede delinearse como una capa de 
segmentos y ser extraída del mapa MUN_CAMPO_ELIAS, sin embargo en la base de datos dispuesta 
para este ejercicio  tenemos una capa llamada HIDROGRAFIA_TRUJILLO (Cuadro 1), la cual fue 
extraída de un MED y traza el sistema de drenaje del estado Trujillo con mayor precisión. 
 
7.1.-  Despliegue el mapa MUN_CAMPO_ELIAS, y revise el sistema de drenaje que este mapa ofrece. 

Vaya al ícono de superposición     y click en la capa HIDROGRAFIA_TRUJILLO, observe el 
desplazamiento que presentan los drenajes (Figura 7.1.), esto se debe a que los productos cartográficos 
no son absolutamente precisos y esta diferencia puede ser el resultado de: 

- Mapa  mal georreferenciado 
- Mapas corresponden originalmente a diferentes escalas 
- Mapas con sistemas de proyección diferentes 
- Mapas de diferente formato y fuentes, por ejemplo si un mapa proviene de un  fotocopiado o 

escaneado previo a su digitalización, este seguramente presenta deformaciones. Una fuente digital 
como son las imágenes y datos satelitales presenta una mayor precisión.    
 
Dado que la capa HIDROGRAFIA_TRUJILLO fue extraída de un MED de mayor precisión 
cartográfica que el mapa raster del municipio, tomaremos este trazado del drenaje como auténtico.  
 

 
Figura 7.1 
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8.- CONSECUENCIAS DE LA ACTUALIZACIÓN CARTOGRÁFICA. CORRECCIÓN DE 
LÍMITES 
 
Hacer un portafolio implica hacer una colección sistemática de capas y documentos cartográficos, en 
este caso si bien el mapa raster TRUJILLO_MUNICIPIOS, nos ayuda a la localización y hechos 
geográficos de un municipio determinado, el uso de data cartográfica de mayor precisión nos impone 
corregir el resto del material. La superposición de la capa HIDROGRAFIA_TRUJILLO sobre el mapa 
base MUN_CAMPO_ELIAS, evidencia el desplazamiento existentes entre los hechos geográficos 
representados.  
 
En este ejercicio se corregirán los límites municipales y por consiguiente los parroquiales. Los límites 
del municipio Campo Elías como la mayoría de de los municipios del estado Trujillo son delineados a 
través de dos tipos de hechos geográficos: Los drenajes/valles y las filas/sierras.   
 
8.1.- Despliegue el mapa raster MUN_CAMPO_ELIAS y superpongale las capas de segmentos   
HIDROGRAFIA_TRUJILLO y MUNICIPIO_CAMPO_ELIAS. Todo el límite oeste del municipio 
esta señalado por el la combinación Río Azul – Río Negro – Río Boconó, sin embargo el límite 
municipal que se delineó en el item 4 no corresponde exactamente con el trazado de estos cursos 
(Figura 8.1), se debe entonces comenzar la corrección de límites en esta sección (ítem 8.1a). 
Igualmente en las nacientes de la Quebrada La Cuchilla en el centro NE el límite debe seguir el drenaje 
(ítem 8.1b), y hacia el centro S el límitre debe seguir el curso del Rio Saguáz (ítem 8.1c) 
 

 
Figura 8.1 
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8.2.- Edite la capa de límites municipales mediante los comandos  Edit > Edit Layer > 

MUNICIPIO_CAMPO_ELIAS, con la herramienta de corte , intercepte y corte el límite oeste del 
municipio tanto al norte como al sur, de esta manera aislamos este segmento del resto. Elimine este 
segmento y proceda a digitalizar de nuevo esta sección pero en este caso siguiendo el curso de los ríos 
Río Azul – Río Negro – Río Boconó, repita el procedimiento para la quebrada La Cuchilla y el Río 
Saguáz (Figura 8.2).  
 
 
 

 
Figura 8.2 

 
 
 
Una vez trazado el nuevo límite, revise los segmentos mediante las herramientas descritas en el ítem 
4.5, salga del editor, cierre las ventanas de despliegue y regrese a la pantalla maestra del ILWIS. 
 
 
 
8.3.- Hasta aquí se ha corregido desplazamientos en ciertas secciones del límite municipal 
particularmente aquellas visibles con la data seleccionada y señaladas por drenajes/valles. Ahora se 
debe corregir secciones del límite municipal que son descritas por filas/sierras, en este caso 
utilizaremos el MED del municipio como guía. En la pantalla maestra despliegue el 
MED_CAMPO_ELIAS y superponga las capas  HIDROGRAFIA_TRUJILLO y 
MUNICIPIO_CAMPO_ELIAS (Figura 8.3). 
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Figura 8.3 

 
 
 
8.4.- Note como la hidrografía recorre las partes mas bajas del MED las cuales se ilustran con la gama 
de colores tendentes al verde – azul. Las cumbres o filas están ilustradas con los colores tendentes al 
ocre – magenta, el ejercicio es determinar en que secciones el límite municipal viene señalado por filas 
montañosas.  
 
Para este caso se recomienda cambiar temporalmente la representación del MED del pseudocolor  al 
gris (GRAY), y para el caso de la capa MUNICIPIO_CAMPO_ELIAS , cambiar al rojo, según el 
ejemplo dado en las figuras 8.4a y 8.4b, de esta manera se podrá discriminar con mayor detalle el 
desplazamiento de límites. 
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Figura 8.4a 

 

 
Figura 8.4b 
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8.5.-  Revise el MED en gris, y corrobore la distribución de las tonalidades, las mas oscuras 
corresponden a los valles por donde discurre el drenaje, las más claras son las partes mas altas del 
sistema montañoso, en algunos sectores el límite municipal es señalado por estas filas. 
 
La figura 8.5,  ilustra los casos más evidentes donde el límite inicial (color rojo) esta desplazado con 
respecto al hecho topográfico (cumbrera o fila en azul claro).  
 
 

 
Figura 8.5 

 
 
 
 
8.6.- Edite la capa de segmentos MUNICIPIO_CAMPO_ELIAS y corrija estos desplazamientos, revise 
luego los nuevos segmentos y salga del editor. Luego despliegue el mapa raster 
MUN_CAMPO_ELIAS y superpongale nuevamente los límites municipales,  compare el resultado con 
la figura 8.6. Cierre las ventanas desplegadas y  regrese a la pantalla maestra del ILWIS. 
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Figura 8.6 

 
 
 
9.- Ahora procedemos a digitalizar los límites parroquiales. Para esto copiaremos el mapa de segmentos  
MUNICIPIO_CAMPO_ELIAS pero asignándole un nuevo nombre relativo a las parroquias. 
Seleccione con un click el mapa de segmentos MUNICIPIO _CAMPO_ELIAS y luego vaya a los 
comandos Edite > Copy Object To… y se desplegará una ventana de diálogo donde escribirá el nombre 
PARROQUIA_CAMPO_ELIAS. Click OK  ( Figura 9.1). 
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Figura 9.1 

 
9.2.- Repita el procedimiento de copia y genere el mapa correspondiente a la parroquia Arnaldo 
Gabaldón (Figura 9.2) 
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Figura 9.2 

 
9.3.- Compruebe en la pantalla maestra del 
ILWIS que efectivamente se han creado estas dos 
copias de limites 
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9.4.- Estas capas de segmentos son una copia de los limites municipales, por lo tanto debemos editarlos 
y de esta manera delinear los límites parroquiales. Despliegue el mapa raster MUN_CAMPO_ELIAS, 
luego superpóngale la capa de segmentos correspondiente a la parroquia Campo Elías mediante el 

ícono , una vez superpuesto procedemos a editar la capa de segmentos mediante los comandos Edit 
> Edit Layer > 2seg parroquia_campo_elias (Figura 9.4). 
 
 

 
Figura 9.4. 
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9.5.- Una vez en el modulo de digitalización, trace el límite que separa la parroquia Campo Elías , 
de la vecina, elimine los límites restantes de la parroquia Arnoldo Gabaldón y una vez terminado revise 
la consistencia de los segmentos mediante el modulo de chequeo (ítem 4.5). Los Segmentos que 
definen el límite parroquial deben conformar un polígono cerrado. Una vez terminada la digitalización 

salga del editor de mapas de segmentos , de esta manera todo el trazado elaborado se guarda 
automáticamente (Figura 9.5). 
 

 
Figura 9.5 

 
9.6.- Ahora edite de igual manera la parroquia Arnaldo Gabaldón, una vez terminado despliegue las 
capas de segmentos de las parroquias  
 

 
Figura 9.6 
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9.7.- La forma, posición y extensión de la ciudad de Campo Elías también puede corregirse y 
actualizarse. Para ello utilizaremos el mapa raster de COBERTURAS_1996 con este propósito, ya que 
en esta capa raster es posible visualizar e interpretar coberturas como viales y urbanas. 
 
 
9.8.- Despliegue el mapa COBERTURAS_1996, superponga la capa de segmentos CAMPO_ELIAS, 
examine el lugar donde el mapa MUN_CAMPO_ELIAS localiza la ciudad y donde efectivamente se 
asienta esta (Figura 9.8)   
 
 
 

 
Figura 9.8 
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9.9.- Edite la capa de segmentos CAMPO_ELIAS mediante los comandos Edit > Edit Layer > 2seg 
campo_elias (Figura 9.9), y trace la verdadera forma, extensión y localización de la ciudad de Campo 
Elías, la cual es la correspondiente a la interpretada en el mapa COBERTURAS_1996. Revise la 
consistencia de los segmentos y salga del editor. 
 
 
 
 
 

 
Figura 9.9 

 
 
 
 

HAGA UNA CAPTURA DE 
PANTALLA DE ESTE 
TRAZADO DE SEGMENTOS Y 
PONGALA EN LA PLANTILLA 
DE EVALUACIÓN 

 

 
 
Cierre todas las ventanas y regrese a la pantalla maestra del ILWIS. 
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10.- CREANDO CAPAS DE POLIGONOS. Los mapas de segmentos  y mapas de polígonos , 
son mapas vectoriales, mientras los segmentos dan cuenta de la conectividad de los vectores, los 
polígonos representan el área contenida por un conjunto de vectores. Para operaciones espaciales y 
algebra de mapas, en la mayoría de los SIG,  los mapas de polígonos deben ser rasterizados a una 

georreferencia  que defina el tamaño de celda. En esta parte del ejercicio, se crearan los polígonos 
que representen el municipio Juan Vicente Campo Elías y las parroquias Campo Elías y Arnoldo 
Gabaldón. 
 
10.1 Para generar estas capas de polígonos del mapa de segmentos MUNICIPIO_CAMPO_ELIAS, se 
requiere crear una etiqueta que asigne una categoría al área contenida en los vectores. Esta etiqueta se 

genera mediante un mapa de puntos . 
 
10.2.- Despliegue la capa MUNICIPIO_CAMPO_ELIAS, a través de los comandos  File > Create > 
Point Map, genere un mapa de puntos llamado MUNICIPIO_CAMPO_ELIAS (Figura 10.2). Dado que 
el mapa se esta creando sobre la capa MUNICIPIO_CAMPO_ELIAS, éste utilizará el sistema de 

coordenadas  TRUJILLO_MUNICIPIOS. 
 

 
Figura 10.2 

 



 37 

10.3.- El sistema ofrece crear el mapa bajo un dominio Unique ID, sin embargo se recomienda crear un 
dominio clase que integre las características geográficas que queremos definir en este ejercicio. Haga 

click en la casilla inmediata a la voluta de desplazamiento  , y abra la ventana de dialogo para crear 

el nuevo dominio . Escriba ENTIDADES como Domain Name y active la casilla class, lo cual es 
indicativo que el dominio a crear es de clases. Click OK en la ventana de Create Domain.  
 

 
Figura 10.3 

 
 
 
10.4.- Se despliega la ventana de dialogo para la creación de este dominio clases. En este dominio se 
crearán las diferentes clases con las cuales se describirán los tipos de entidad político administrativa a 

encontrar en el municipio. Para añadir estas clases haga clic  en el ícono . Las clases a añadir son: 
MUNICIPIO CAMPO ELIAS,  PARROQUIA CAMPO ELIAS,  PARROQUIA ARNOLDO 

GABALDÓN y CAMPO ELIAS. Posteriormente y a través del ícono ; seleccione los colores 
representativos de éstas (Figura 10.4).  
 
Luego cierre la ventana de representación y click en el dominio ENTIDADES y luego click en Create 
Point Map MUNICIPIO CAMPO ELIAS.  
 
 
 
 



 38 

 
Figura 10.4 

10.5.- Una vez en el Point Editor, utilice la herramienta , para insertar un punto dentro de los 
límites del municipio, ese punto debe asignarse como MUNICIPIO CAMPO ELIAS (Figura 10.5) 

termine y salga del editor ., de esta manera ya se creo el primer mapa de puntos. Cierre todas las 
ventanas de despliegue y regrese a la pantalla maestra del ILWIS.      
              

 
Figura 10.5 
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10.6.- Proceda a poligonizar, ubíquese en la pantalla maestra del ILWIS y haga click con el botón 
derecho del ratón sobre el mapa de segmentos MUNICIPIO_CAMPO_ELIAS. Seleccione el comando 
Vectorice > Segment to Polygon… La ventana de dialogo (Figura 10.6a), le pedirá la etiqueta a utilizar 
en la poligonización, escoja el mapa de puntos MUNICIPIO CAMPO ELIAS elaborado para tal fin. 
Clic en Show y despliegue el mapa de polígonos. Cierre el mapa (Figura 10.6b) y regrese a la pantalla 
maestra del ILWIS.  
 

 
Figura 10.6a 

 
 
 

 
Figura 10.6b 

HAGA UNA CAPTURA DE 
PANTALLA DE ESTE MAPA 
DE  POLIGONOS Y PONGALO 
EN LA PLANTILLA DE 
EVALUACIÓN 
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11.- Igualmente para generar las capas de polígonos de las parroquias se requiere crear una etiqueta que 
asigne una categoría al área contenida en los vectores. Esta etiqueta se genera mediante un mapa de 

puntos . Despliegue la capa PARROQUIA_CAMPO_ELIAS, luego a través de los comandos  File 
> Create > Point Map, genere un mapa de puntos llamado PARROQUIA_CAMPO_ELIAS . 
 
El sistema ofrece crear el mapa bajo un dominio Unique ID, sin embargo ya hemos creado un dominio 
que representa las características que queremos definir en este ejercicio. Seleccione el dominio 
ENTIDADES y click en Create Point Map  PARROQUIA_CAMPO_ELIAS (Figura 11.1a).  
 

 
Figura 11.1a 

 

Una vez en el Point Editor, utilice la herramienta , para insertar un punto dentro de los límites de 
la parroquia, ese punto debe asignarse como PARROQUIA_CAMPO_ELIAS (Figura 11.1b) termine y 

salga del editor . Cierre todas las ventanas de despliegue y regrese a la pantalla maestra del ILWIS.    
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Figura 11.1b 

 
11.2.- Proceda a poligonizar, ubíquese en la pantalla maestra del ILWIS y haga click con el botón 
derecho del ratón sobre el mapa de segmentos PARROQUIA_CAMPO_ELIAS. Seleccione el 
comando Vectorice > Segment to Polygon… La ventana de dialogo (Figura 11.2), le pedirá la etiqueta a 
utilizar en la poligonización, escoja el mapa de puntos PARROQUIA_CAMPO_ELIAS elaborado para 
tal fin. Click en Show y despliegue el mapa de polígonos. Cierre el mapa (Figura 11.2b) y regrese a la 
pantalla maestra del ILWIS.  
 

 
Figura 11.2a 
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Figura 11.2b 

HAGA UNA CAPTURA 
DE PANTALLA DE 
ESTE MAPA DE  
POLIGONOS Y 
PONGALO EN LA 
PLANTILLA DE 
EVALUACIÓN 

 

 

 
11.3.- Despliegue la capa de segmentos PARROQUIA_ARNOLDO_GABALDON, luego a través de 
los comandos  File > Create > Point Map, genere un mapa de puntos llamado 
PARROQUIA_ARNOLDO_GABALDON. Seleccione el dominio ENTIDADES y click OK en Create 
Point Map  (Figura 11.3).  
 

 
Figura 11.3 
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11.4.- Una vez en el Point Editor, utilice la herramienta , para insertar un punto dentro de los 
límites de la parroquia, ese punto debe asignarse como PARROQUIA_ARNOLDO_GABALDON 

(Figura 11.4) termine y salga del editor .. Cierre todas las ventanas de despliegue y regrese a la 
pantalla maestra del ILWIS.                   

 
Figura 11.4 

 
 
11.5.- Proceda a poligonizar, ubíquese en la pantalla maestra del ILWIS y haga click con el botón 
derecho del ratón sobre el mapa de segmentos PARROQUIA_ARNOLDO_GABALDON. Seleccione 
el comando Vectorice > Segment to Polygon… La ventana de dialogo (Figura 11.5a), le pedirá la 
etiqueta a utilizar en la poligonización, escoja el mapa de puntos 
PARROQUIA_ARNOLDO_GABALDON elaborado para tal fin. Click en Show y despliegue el mapa 
de polígonos. Cierre el mapa (Figura 11.5b) y regrese a la pantalla maestra del ILWIS.  
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Figura 11.5a 

 
 

 
Figura 11.5b 

HAGA UNA CAPTURA DE 
PANTALLA DE ESTE MAPA DE  
POLIGONOS Y PONGALO EN 
LA PLANTILLA DE 
EVALUACIÓN 

 

 

 
 
Cierre todas las ventanas y regrese a la pantalla maestra del ILWIS. 
 
 
 



 45 

11.6.- Despliegue la capa de segmentos CAMPO_ELIAS, luego a través de los comandos  File > 
Create > Point Map, genere un mapa de puntos llamado CAMPO_ELIAS. Seleccione el dominio 
ENTIDADES y click OK en Create Point Map  (Figura 11.6).  
 
 
 

 
Figura 11.6 

 
 

11.7.- Una vez en el Point Editor, utilice la herramienta , para insertar un punto dentro de los 
límites de la ciudad de Campo Elias, ese punto debe asignarse como CAMPO ELIAS (Figura 11.7) 

termine y salga del editor .. Cierre todas las ventanas de despliegue y regrese a la pantalla maestra 
del ILWIS.                   
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Figura 11.7 

 
 
11.8.- Proceda a poligonizar, ubíquese en la pantalla maestra del ILWIS y haga click con el botón 
derecho del ratón sobre el mapa de segmentos CAMPO_ELIAS. Seleccione el comando Vectorice > 
Segment to Polygon… La ventana de dialogo (Figura 11.8a), le pedirá la etiqueta a utilizar en la 
poligonización, escoja el mapa de puntos CAMPO_ELIAS elaborado para tal fin. Click en Show y 
despliegue el mapa de polígonos. Cierre el mapa (Figura 11.8b) y regrese a la pantalla maestra del 
ILWIS.   
 

 
Figura 11.8a 
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Figura 11.8b 

HAGA UNA CAPTURA DE 
PANTALLA DE ESTE MAPA DE  
POLIGONOS Y PONGALO EN 
LA PLANTILLA DE 
EVALUACIÓN 

 

 

 
12.- VECTORIZAR UNA CAPA RASTER A UNA CAPA DE POLÍGONOS 
 
12.1.- En los SIG, las capas raster son las más pesadas desde el punto de vista digital ya que cada celda 
que la conforma contiene información individualizada, por esta razón son las capas raster las  
requeridas para el análisis, procesamiento y modelamiento de datos geográficos. 
 
Sin embargo para la presentación e impresión final de estos datos geográficos el formato preferido es el 
vectorial, por ser este de traza más limpia, por esta razón todo SIG tiene entre sus aplicaciones la 
conversión de estos formatos. 
 
Teóricamente cualquier capa raster podría ser convertida en una capa vectorial pero en la practica esto 
no es recomendable puesto que algunas capas raster como los MED son muy complejas. 
 
Por lo general las capas raster candidatas a la conversión son aquellas cuyos datos ya han sido 
clasificados a rangos finitos y que la distribución espacial de estos es continua y poco dispersa. En este 
ejercicio existen capas raster tales como:  PISOS_TERMICOS, PISOS_ALTITUDINALES, 
GEOMORFOLOGIA o TEMPERATURAS, que podrían ser utilizados más cómodamente en un 
formato vectorial.         
 
12.2.- En la pantalla maestra del ILWIS despliegue el mapa PISOS_TERMICOS,  y superponga el 
mapa de segmentos: MUNICIPIO_CAMPO_ELIAS, recorra la vista y revise cuantos pisos 
térmicos están presentes en el municipio, igualmente haga un acercamiento en áreas limítrofes de 
clases, de esta manera observe la textura del límite (Figura 12.2). Luego de esto cierre el despliegue y 
vuelva a la pantalla maestra.  
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Figura 12.2 

 
12.3.- En la pantalla maestra del ILWIS, ubique el mapa raster PISOS_TERMICOS y click con el boton 
derecho del ratón, esta es otra manera de desplegar los comandos del ILWIS, seleccione Vectorize > 
Raster to Polygon. En la pantalla de diálogo escriba como mapa de salida el mismo nombre y active la 
casilla Smooth Lines que se refiere al suavizado de los límites de los polígonos resultantes. Click en 
Show (Figura 12.3). 
 

 
Figura 12.3 

 
12.4.- Una vez desplegada la nueva capa de polígonos PISOS_TERMICOS,  superponga el mapa de 
segmentos: MUNICIPIO_CAMPO_ELIAS, recorra la vista y haga un acercamiento en áreas limítrofes de 
clases, de esta manera observe el acabado final del mapa de polígonos y la textura del límite (Figura 
12.4) y compare con el presentado por la  capa raster (Figura 12.2). Luego de esto cierre el despliegue y 
vuelva a la pantalla maestra. 
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Figura 12.4 

 
12.5.- Repita el procedimiento para el mapa raster PISOS_ALTITUDINALES y click con el boton derecho 
del ratón, esta es otra manera de desplegar los comandos del ILWIS, seleccione Vectorize > Raster to 
Polygon. En la pantalla de diálogo escriba como mapa de salida el mismo nombre y active la casilla 
Smooth Lines que se refiere al suavizado de los límites de los polígonos resultantes. Click en Show 
(Figura 12.5). 
 

 
Figura 12.5 

 
12.6.- Una vez desplegada la nueva capa de polígonos PISOS_ALTITUDINALES,  superponga el mapa de 
segmentos: MUNICIPIO_CAMPO_ELIAS, recorra la vista, examine cuantos pisos altitudinales tiene el 
municipio Campo Elías. Despliegue también la capa raster PISOS_ALTITUDINALES y compare en una 
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misma pantalla ambas capas (Figura 12.6). Luego de esto cierre el despliegue y vuelva a la pantalla 
maestra. 
 

 
Figura 12.6 

 
12.7.- En el caso del mapa raster GEOMORFOLOGIA, a pesar de presentar un número finito de clases su 
dispersión y discontinuidad hace difícil el mejoramiento de su textura mediante la conversión de 
formato. Si su computadora lo acepta y no se cuelga, probablemente el resultado de sectorizar esta capa 
raster será el ilustrado en la figura 12.7, de tal manera que esta capa se mantendrá en formato raster y 
para su uso como parte del portafolio del municipio Campo Elías, se recortará según los límites 
especificados en el ítem 3.1. 
 
12.8.- El mapa de distribución de las temperaturas medias anuales en el estado Trujillo además de estar 
en formato raster, el dominio en el que se expresan sus unidades es de valor. El mapa posee un rango 
que va desde los -1,3 °C a los 28,3 °C, correspondiendo obviamente las menores temperaturas a las 
zonas montañosas y las mayores a las planicies por debajo de los 200 msnm. En este tipo de dominio el 
ILWIS no vectoriza puesto que requiere un dominio discreto de clases / grupo. Se recomienda entonces 
utilizar este mapa en este formato, recortarlo al mapa base del municipio. Por lo general los mapas de 
distribución de las temperaturas y de precipitación se utilizan en dominio de valor.      
 
12.9.- Igualmente el mapa geológico debe recortarse al mismo tamaño del mapa base del municipio 
Campo Elías y así incluirlo en el portafolio municipal. 
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Figura 12.7 

 
 
13.- IMPORTAR, REMUESTRAR Y VECTORIZAR UNA CAPA RASTER A UNA CAPA DE 
POLÍGONOS. 
 
13.1.- Una parte importante del territorio son las áreas bajo régimen especial (ABRAE), las cuales son 
áreas que reconocen la riqueza natural de un espacio, bioma o punto territorial, y su necesidad de 
preservarlo bajo distintas modalidades. Para este ejercicio se utilizará una imagen raster tomada del 
trabajo digital: Áreas Bajo Régimen de Administración Especial (ABRAE) en Trujillo – Venezuela 
(http://www.nurr.ula.ve/tallerticeducacion/), la cual ofrece un mapa donde se delinean los límites de las 
ABRAE dentro del estado Trujillo, asimismo ofrece una descripción de los tipos y objetivos de cada 
área. Este trabajo fue realizado para introducir a los estudiantes de escuela básica sobre las ABRAE 
locales de una manera interactiva para ser usado en las computadoras CANAIMA mediante un 
explorador web. 
 
Este mapa está en formato GeoTiff, lo cual es un estándar que permite que la georeferencia de un mapa 
o capa cartográfica raster se enlace al archivo de imagen de formato TIFF, en otras palabras, una 
imagen / mapa / capa,  de alta resolución (Tiff), contiene información espacial relativa a su proyección, 
elipsoide, datum y sistemas de coordenadas (Geo). 
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La importación de un mapa en formato GeoTiff a un SIG facilita su lectura, ahorra el proceso de 
georreferenciación manual y asegura una mayor precisión de la data. El archivo a importar se llama 
abrae_trujillo.tif  y se encuentra en la data provista para el ejercicio sin embargo, no puede ser 
visualizada a través del explorador del ILWIS ya que aún no ha sido importada.     
13.2.- Para hacer la importación vaya a File > Import > General Raster  (Figura 13.2) 
 

 
Figura 13.2  

 
13.3.- En la ventana de dialogo (Figura 13.3),  escoja Tagged Image File Format.TIF como formato de 
importación (Import Format), luego seleccione el archivo abrae_trujillo.tif, y asigne como nombre de 
archivo de salida (Output Filename) el mismo nombre, click OK. 
 

 
Figura 13.3  
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13.4.- Este protocolo permite entonces la importación de una imagen GeoTiff,  transformando esta en 
formato ILWIS y de esa manera su lectura y procesamiento dentro del SIG. Una vez importada dentro 
del ILWIS la imagen muestra además del archivo del mapa, los correspondientes a su sistema de 
coordenadas y georeferencia. (Figura 13.4a). Despliegue el mapa ABRAE_TRUJILLO (Figura 13.4b), y 
diferencie en el los límites municipales y los límites de las ABRAE. Hasta este momento este mapa no 
posee una leyenda que señale los nombres de las ABRAE.  
 

 
Figura 13.4a  

 
 

 
Figura 13.4b 

 
13.5.- El mapa importado debe ser remuestreado  para de esta manera adecuarlo a las georreferencias 
utilizadas por las demás capas de este ejercicio. Vaya a la Operation List  y seleccione el comando 
Resample, en la ventana de diálogo escoja el mapa ABRAE_TRUJILLO, como nombre de salida 
escriba  ABRAE_TRUJILLO_1, como georreferencia seleccione MED8 y como metodo de remuestreo 
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Bilinear (Figura 13.5a). Despliegue el mapa ABRAE_TRUJILLO_1 y comparelo con el anterior 
ABRAE_TRUJILLO (Figura 13.5b).  
 

 
Figura 13.5a 

 

 
Figura 13.5b 

 
Luego de esto cierre el despliegue y vuelva a la pantalla maestra.  
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13.6.- Para la digitalización y posterior poligonización de las ABRAE en Trujillo, procedemos a copiar 
la capa de segmentos TRUJILIMITE pero bajo el nombre de ABRAE_TRUJILLO_2 (Figura 13.6).  
 

 
Figura 13.6. 

 
 
 
13.7.- Despliegue el mapa 
ABRAE_TRUJILLO_1, y superpóngale la 
capa de segmentos ABRAE_TRUJILLO_2.  
Edite esta última con la secuencia de 
comandos Edit > Edit Layer > 2seg 
abrae_trujillo_2 (Figura 13.7)  
 

 
Figura 13.7 

 
 
13.8.- Una vez en la pantalla de edición trace los segmentos correspondientes a los límites de las 

ABRAE , una vez terminado revise la consistencia de los segmentos mediante el modulo de 

chequeo, los íconos . y  , son útiles para la corrección de los problemas de solapamiento, 
intersección y terminaciones que puedan presentar los segmentos. 
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Los segmentos se definen según el dominio de la 
capa TRUJILIMITE el cual es LIMITE (Figura 
13.8).  
Los segmentos que conforman cada ABRAE 
deben conformar un polígono cerrado. Una vez 
terminada la digitalización salga del editor de 

mapas de segmentos , de esta manera todo el 
trazado elaborado se guarda automáticamente. 
 

 
Figura 13.8 

 
13.9.- Una vez digitalizados los límites de las ABRAE, debemos crear el dominio y representación que 
señale los nombres de las ABRAE y sus colores representativos. En la pantalla maestra del ILWIS vaya 
a los comandos de creación de un dominio clase, File > Create > Domain…y escriba los nombres de 
las ABRAE en Trujillo, luego cierre la ventana del Domain Class y click OK en la ventana de Create 
Domain (Figura 13.9). 
 

 
Figura 13.9 
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13.10.- Para generar las capas de 
polígonos de las ABRAE se 
requiere crear una etiqueta que 
asigne una categoría al área 
contenida entre los segmentos de 
la capa. Esta etiqueta se genera 

mediante un mapa de puntos . 
Despliegue la capa 
ABRAE_TRUJILLO_1, 
superpóngale la capa de segmentos 
ABRAE_TRUJILLO_2, luego a 
través de los comandos  File > 
Create > Point Map, genere un 
mapa de puntos llamado 
ABRAE_TRUJILLO_2. 
El sistema ofrece crear el mapa 
bajo un dominio Unique ID, sin 
embargo ya hemos creado un 
dominio que representa las 
características que queremos 
definir en este ejercicio. 
Seleccione el dominio 
ABRAE_TRUJILLO_2 y click en 
Create Point Map  (Figura 13.10).  

 
Figura 13.10 

 

 

13.11.- Una vez en el Point Editor, utilice la herramienta , para insertar un punto dentro de los 
límites de cada ABRAE, verifique con la fuente consultada el nombre de cada ABRAE y su 

localización (Figura 13.11) termine y salga del editor . Cierre todas las ventanas de despliegue y 
regrese a la pantalla maestra del ILWIS.            
 

 
Figura 13.11 
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13.12.- Proceda a poligonizar, ubíquese en la pantalla maestra del ILWIS y haga click con el botón 
derecho del ratón sobre el mapa de segmentos ABRAE_TRUJILLO_2. Seleccione el comando 
Vectorice > Segment to Polygon… La ventana de dialogo (Figura 13.12a), le pedirá la etiqueta a 
utilizar en la poligonización, escoja el mapa de puntos ABRAE_TRUJILLO_2, y escriba como mapa 
de salida el mismo nombre. Click en Show y despliegue el mapa de polígonos. Puede cambiar los 
colores de la representación a su conveniencia por simple click en cada color expuesto en la leyenda. 
Cierre el mapa (Figura 13.12b) y regrese a la pantalla maestra del ILWIS.  
 

 
Figura 13.12a. 

 
 

 
Figura 13.12b 
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HAGA UNA CAPTURA DE 
PANTALLA DE ESTE MAPA 
DE  POLIGONOS Y PONGALO 
EN LA PLANTILLA DE 
EVALUACIÓN 

 


